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Warranty
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documentation that is not customarily 
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documentation. No additional government 
requirements beyond those set forth in the 
EULA shall apply, except to the extent that 
those terms, rights, or licenses are explicitly 
required from all providers of commercial 
computer software pursuant to the FAR and 
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writing elsewhere in the EULA. Keysight 
shall be under no obligation to update, 
revise or otherwise modify the Software. 
With respect to any technical data as 
defined by FAR 2.101, pursuant to FAR 
12.211 and 27.404.2 and DFARS 227.7102, 
the U.S. government acquires no greater 
than Limited Rights as defined in FAR 27.401 
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Safety Notices

CAUTION

A CAUTION notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or 
adhered to, could result in damage 
to the product or loss of important 
data. Do not proceed beyond a 
CAUTION notice until the indicated 
conditions are fully understood and 
met.

WARNING

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the l ike that, if not correctly 
performed or adhered to, could 
resul t in personal injury or death. 
Do not proceed beyond a WARNING 
notice until the ind icated 
conditions are fully understood and 
met.

http://www.keysight.com/find/sweula
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Hybrid Memory Cube Compliance Test Application—At a Glance
The Keysight N8839A Hybrid Memory Cube Compliance Test Application is a test 
solution that covers the electrical timing parameters for Hybrid Memory Cube 
Specification 2.1.

The Hybrid Memory Cube Compliance Test Application:

• Lets you select individual or multiple tests to run.

• Lets you identify the device being tested and its configuration.

• Shows you how to make oscilloscope connections to the device under test.

• Automatically checks for proper oscilloscope configuration.

• Automatically sets up the oscilloscope for each test.

• Allows you to determine the number of trials for each test.

• Provides detailed information of each test that has been run. The result of 
maximum 64 worst trials can be displayed at any one time.

• Creates a printable HTML report of the tests that have been run. This report 
includes pass/fail limits, margin analysis, and screen shots.

Required
Equipment and

Software

In order to run the Hybrid Memory Cube automated tests, you need the following 
equipment and software:

Product Description Notes

DSO/DSAZ504A Infiniium Oscilloscope: 50 GHz 45 GHz and above for 
30 Gb/s data rate

N8839A-1FP, or HMC Compliance Test Software, fixed perpetual 
license

Required

N5435A-101 HMC Compliance Test Software, server based 
license

N8839A-7FP, or Switch matrix option, fixed perpetual license Optional

N5435A-717 Switch matrix option, server based license

E2688A-1FP Serial data analysis software Required

N5400A-1FP EZJIT Plus Software Required

N5465A-1FP InfiniiSim Software – Advanced license Recommended for probe 
correction

N5234A Network analyzer, 43.5 GHz Required for up to 30 Gb/s 
return loss testing
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1 Installing the N8839A 
Compliance Test Application

Installing the Software / 8
Installing the License Key / 9

If you purchased the N8839A Compliance Test Application separate from your 
Infiniium oscilloscope, you need to install the software and license key.
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1 Installing the N8839A Compliance Test Application
 

Installing the Software

1 Make sure you have the minimum version of Infiniium oscilloscope software 
(see the N8839A release notes) by choosing Help > About Infiniium... from the 
main menu.

2 To obtain the N8839A Compliance Test Application, go to Keysight website: 
http://www.keysight.com/support/N8839A

3 The link for N8839A Hybrid Memory Cube Compliance Test Application will 
appear. Double-click on it and follow the instructions to download and install 
the application software.

http://www.keysight.com/find/N8830A


Installing the N8839A Compliance Test Application 1

Keysight N8839A Hybrid Memory Cube Compliance Test Application Methods of Implementation 9

 

Installing the License Key

1 Request a license code from Keysight by following the instructions on the 
Entitlement Certificate.

You will need the oscilloscope's "Option ID Number", which you can find in the 
Help > About Infiniium... dialog box.

2 After you receive your license code from Keysight, choose Util ities > Install Option 
License....

3 In the Install Option License dialog box, enter your license code and click Install 
License.

4 Click OK in the dialog box that tells you to restart the Infiniium oscilloscope 
application software to complete the license installation.

5 Click Close to close the Install Option License dialog box.

6 Choose File > Exit.

7 Restart the Infiniium oscilloscope application software to complete the license 
installation.
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1 Installing the N8839A Compliance Test Application
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2 Preparing to Take 
Measurements

Calibrating the Oscilloscope / 12
Starting the Compliance Test Application / 13

Before running the automated tests, you should calibrate the oscilloscope and 
probe. No test fixture is required for this application. After the oscilloscope and 
probe have been calibrated, you are ready to start the N8839A Compliance Test 
Application and perform the measurements.
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2 Preparing to Take Measurements
 

Calibrating the Oscilloscope

If you haven't already calibrated the oscilloscope, see Appendix A, “Calibrating the 
Infiniium Oscilloscope and Probe,” starting on page 35.

NOTE If the ambient temperature changes more than 5 degrees Celsius from the calibration 
temperature, internal calibration should be performed again. The delta between the 
calibration temperature and the present operating temperature is shown in the Util ities > 
Calibration menu.

NOTE If you switch cables between channels or other oscilloscopes, it is necessary to perform cable 
and probe calibration again. Keysight recommends that, once calibration is performed, you 
label the cables with the channel on which they were calibrated.
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Starting the Compliance Test Application

1 Ensure that the Device Under Test (DUT) is operating and set to desired test 
modes.

2 To start the Compliance Test Application: From the Infiniium oscilloscope's 
main menu, choose Analyze > Automated Test Apps > N8839A Hybrid Memory Cube 
Test App.

The task flow pane, and the tabs in the main pane, show the steps you take in 
running the automated tests:

Figure 1 N8839A Compliance Test Application Main Window
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2 Preparing to Take Measurements
 

Set Up Lets you identify and set up the test environment, including information 
about the device under test.
The Device Identifier, User Description, and Comments are all printed in 
the final HTML report.
Select the device speed to be tested.
Set up InfiniiSim with the InfiniiSim Setup button.
With the Set Channel skew button, the channels can be visually adjusted 
and skewed.
The Saved Waveform Setup button enables easy setup of saved 
waveforms. When waveforms are set up, the application will make all 
measurements on the saved waveforms.
The Multi-Lane Option enables you to choose to test a single lane or with 
the switch matrix.

Select Tests Lets you select the tests you want to run. The tests are organized 
hierarchically so you can select all tests in a group. After tests are run, 
status indicators show which tests have passed, failed, or not been run, 
and there are indicators for the test groups.

Configure Lets you configure test parameters (for example, channels used in test, 
Number of UI to test, oscilloscope bandwidth, fixed Rj, etc.).

Connect Shows you how to connect the oscilloscope to the device under test for 
the tests that are to be run.

Run Tests Starts the automated tests. If the connections to the device under test 
need to be changed while multiple tests are running, the tests pause, show 
you how to change the connection, and wait for you to confirm that the 
connections have been changed before continuing.

Automation Lets you construct scripts of commands that drive execution of the 
application.

Resul ts Contains more detailed information about the tests that have been run. You 
can change the thresholds at which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.
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3 Main Voltage Measurements 
(pattern: Square 64)

DC Common Mode Output Voltage Test / 18
AC Common Mode Noise - Square Wave Test / 19
Differential Peak-to-Peak Output Voltage Test / 20

This section provides the Methods of Implementation (MOIs) for the Hybrid 
Memory Cube Main Voltage Measurements using a Keysight Infiniium oscilloscope 
and the N8839A Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as the signal source channel; 
however, for proper BW, use the Real Edge channels for 25 Gb/s and greater. 
Select lane options in the Setup tab. You can identify the channels used for the 
measurement signal in the Setup tab of the Compliance Test Application.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

Figure 2 Probing for Main Voltage Measurements
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3 Main Voltage Measurements (pattern: Square 64)
 

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

6 Set up InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Main Voltage
Specifications

(pattern: Square
64)

The Hybrid Memory Cube specifications can be found in Hybrid Memory Cube 
Spec 2.1 Table 109.

• DC Common Mode Output Voltage (392.85 mV to 509.85 mV)

• AC Common Mode Noise – Square Wave (max 50 mVp-p)

• Differential Peak to Peak Output Voltage (750 mV to 1.025 V)

Figure 3 Selecting Main Voltage Measurement Tests
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• tTX_RISE (min 8 ps)

• tTX_FALL (min 8 ps)
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3 Main Voltage Measurements (pattern: Square 64)
 

DC Common Mode Output Voltage Test

The purpose of this test is to verify that the common mode signal of the differential 
pair is between 392.85 mV and 509.85 mV.

PASS Condition The signal is between 392.85 mV and 509.85 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the min and max voltages of channel (1+3)/2 or channel (2+4)/2.

4 Compare the min and max voltage measurement to 392.85 mV-509.85 mV and 
report margin.

NOTE This measurement can be done only with a dual-single ended connection; it cannot be done 
with a differential probing connection.
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AC Common Mode Noise - Square Wave Test

The purpose of this test is to verify that the common mode signal of the differential 
pair peak-to-peak voltage does not exceed 50 mV on a Square 64 pattern.

This test uses the square wave and measures peak to peak of the signal. The "AC 
Common Mode Noise - PRBS Test" on page 24 will test the rms voltage.

PASS Condition The signal is less than 50 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the peak-to-peak voltage of the channel (1+ 3)/2 or channel (2+4)/2.

4 Compare the voltage measurement to 50 mV and report the margin.

NOTE This measurement can be done only with dual-single ended connection; it cannot be done 
with a differential probing connection.
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3 Main Voltage Measurements (pattern: Square 64)
 

Differential Peak-to-Peak Output Voltage Test

The purpose of this test is to verify that the peak to peak voltage of the differential 
signal on a Square 64 pattern is between 750 mV and 1.025 V.

PASS Condition The differential signal max peak to peak voltage on a Square 64 pattern is between 
750 mV-1.025 V.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected and has a Square 64 pattern.

3 Measure the peak to peak voltage of the differential signal of DUT+ and DUT-.

4 Compare the max peak to peak voltage to 750 mV-1.025 V and report margin.
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4 Jitter and Signaling Rate 
Measurements (pattern: 
PRBS15)

AC Common Mode Noise - PRBS Test / 24
Signaling Rate / 25
Jitter (DJ-Tx, DCD-Tx, RJ-Tx, TJ-Tx) / 26

This section provides the Methods of Implementation (MOIs) for the Jitter and 
Signaling Rate Measurements using a Keysight Infiniium oscilloscope and the 
N8839A Hybrid Memory Cube Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as the signal source channel; 
however, for proper BW, use the Real Edge channels for 15 Gb/s and greater. 
Select lane options in the Setup tab. You can identify the channels used for the 
measurement signal in the Setup tab of the Compliance Test Application.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

Figure 4 Probing for Jitter and Signaling Rate Measurements
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4 Jitter and Signaling Rate Measurements (pattern: PRBS15)
 

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

6 Set up InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

8 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

9 In the Configure tab, select Source fo Rj. This can be either the default EZJIT to 
measure Rj, or User Defined to use a fixed RJ.

If User Defined is selected, enter a value for Fixed Rj Value. Note: this Rj value is 
the Rj(rms) value.

Figure 5 Selecting Jitter and Signaling Rate Tests
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Jitter and
Signaling Rate
Specifications

(pattern: PRBS15)

The Hybrid Memory Cube specifications can be found in Hybrid Memory Cube 
Spec 2.1 Table 109.

• AC Common Mode Noise – PRBS (max 12 mV)

• Signaling Rate (fb ±100 ppm GBd)

• Max output jitter:

• DJ-Tx (max 150 mUI)

• DCD-Tx (max 35 mUI)

• RJ-Tx (max 150 mUI p-p)

• TJ-Tx (max 280 mUI)
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4 Jitter and Signaling Rate Measurements (pattern: PRBS15)
 

AC Common Mode Noise - PRBS Test

The purpose of this test is to verify that the common mode signal of the differential 
pair peak to peak voltage does not exceed 12 mVrms on a PRBS15 pattern.

PASS Condition The signal is less than 12 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the rms voltage of the channel (1+ 3)/2 or channel (2+4)/2.

4 Compare the voltage measurement to 12 mV and report the margin.

NOTE This measurement can be done only with dual-single ended connection; it cannot be done 
with a differential probing connection.
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Signaling Rate

The purpose of this test is to verify that the signaling rate mean is between fb 
±100 ppm GBd.

PASS Condition The mean signaling rate is between fb ±100 ppm GBd.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that signal is connected and data pattern exists (PRBS15).

3 Set memory depth to capture the number of UI set in the configuration tab.

4 Set data rate measurement to semi-automatic f = fb.

5 Measure min, max, mean data rate.

6 Report min and max values.

7 Compare and report the mean data rate value to fb ±100 ppm GBd.
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4 Jitter and Signaling Rate Measurements (pattern: PRBS15)
 

Jitter (DJ-Tx, DCD-Tx, RJ-Tx, TJ-Tx)

The purpose of this test is to verify that differential signal's DJ-Tx Jitter is less than 
150 mUI, DCD-Tx Jitter is less than 35 mUI, RJ-Tx Jitter is less than 150 mUI p-p 
at BER 1E-15, and TJ-Tx Jitter is less than 280 mUI at BER 1E-15. If all tests are 
selected, all tests are run on a single measurement. Each test can be run 
individually by selecting any or some of the tests.

PASS Conditions DJ-Tx Jitter is less than 150 mUI, DCD-Tx Jitter is less than 35 mUI, RJ-Tx Jitter is 
less than 150 mUI p-p at BER 1E-15, and TJ-Tx Jitter is less than 280 mUI at BER 
1E-15.

Measurement
Algorithm

1 In the Configure tab, select Source fo Rj. This can be either the default EZJIT to 
measure Rj, or User Defined to use a fixed RJ.

If User Defined is selected, enter a value for Fixed Rj Value. Note: this Rj value is 
the Rj(rms) value.

2 Obtain sample or acquire signal data.

3 Check that signal is connected and data pattern exists (PRBS15).

4 Set memory depth to capture the number of UI set in the configuration tab.

5 Set clock recovery to OJTF First Order PLL with Nominal Data Rate f=fb and 
Loop Bandwidth to fb/2578.

6 If using EZJIT, with EZJIT Complete, measure DJ-Tx, DCD-Tx, RJ-Tx p-p at BER 
1E-15, and TJ-Tx at BER of 10E-15.

7 If using User Defined fixed Rj, measure DJ-Tx and DCD-Tx with EZJIT Complete, 
use fixed Rj(rms) value to calculate RJ-Tx to BER 1E-15 and using measured 
DJ-Tx and calculated RJ-Tx, calculate TJ-Tx to BER 1E-15.

8 Compare and report the values to their respective maximum specification.
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5 REFCLK Measurements 
(pattern: Clock)

fREFCLK / 29
tDCD_REFCLK / 30

This section provides the Methods of Implementation (MOIs) for the Reference 
clock measurements using the Keysight Infiniium oscilloscope and the N8839A 
Hybrid Memory Cube Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as the signal source channel. You 
can identify the channels used for the measurement signal in the Setup tab of the 
Compliance Test Application. For faster testing, select a different channel pair for 
REFCLK than for the rest of the tests.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

Figure 6 Probing for REFCLK Measurements
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5 REFCLK Measurements (pattern: Clock)
 

4 In the Test application, click the Set Up tab. Select Measurement Option, Lane 
Option, and Channels.

5 Set up Switch matrix (if used) by clicking on the Switch Matrix Setup button.

6 Set up InfiniiSim if needed.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

8 Select the REFCLK frequency.

9 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

REFCLK
Specifications

The REFCLK specifications can be found in Hybrid Memory Cube Spec 2.1 Table 
114.

• fREFCLK (f ±100 ppm MHz)

• tDCD_REFCLK (45%-55%)

Figure 7 Selecting REFCLK Measurements
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fREFCLK

The purpose of this test is to verify that the frequency mean is between f ±100 ppm 
MHz.

PASS Condition The mean data rate is between f ±100 ppm MHz.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure min, max, mean frequency on rising edge.

3 Report min and max values.

4 Compare and report the mean frequency value to f ±100 ppm MHz.
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5 REFCLK Measurements (pattern: Clock)
 

tDCD_REFCLK

The purpose of this test is to verify that the duty cycle is between 45%-55%.

PASS Condition The min and max duty cycle is between 45%-55%.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure min, max, mean duty cycle from rising to rising edge.

3 Report mean value.

4 Compare and report the min and max duty cycle measurements to 45%-55%.
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6 Return Loss ENA/PNA 
Measurements

This section provides the Methods of Implementation (MOIs) for the Return Loss 
Measurements using a Keysight Infiniium oscilloscope, PNA or ENA, and the 
N8839A Compliance Test Application. The Compliance test application controls 
the PNA/ENA to set the test limits and run the test. The calibration must be done 
on the PNA/ENA.

Test Procedure 1 Start the automated test application as described in "Starting the Compliance 
Test Application" on page 13.

2 Calibrate the PNA or ENA.

3 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

4 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

5 Press Run. The test limits are automatically calculated.
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6 Return Loss ENA/PNA Measurements
 

Figure 8 Selecting Return Loss Measurement
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7 Debug Mode

Debug mode can be selected to enable the ability to change jitter measurement 
options. In the Configuration tab, select the Debug radio button. This will add the 
following options:

• Rj Band wid th — Choose the Rj Filter. Options are Narrow (Pink) or Wide (White). 
This changes the amount of DC jitter in the Rj measurement.

• Jitter Pattern Length — Choose Periodic or Arbitrary. Periodic is used for data 
patterns that are periodic and repeat through the oscilloscope memory. 
Arbitrary is used for random data patterns or long data patterns (for example, 
PRBS31) that do not repeat through the oscilloscope memory. If Arbitrary is 
selected, set the ISI filters.

• ISI Fil ter Lead — When using Arbitrary mode for the Jitter Pattern Length, set the 
Leading ISI filter coefficient. To help select the correct ISI filter, see Application 
Note 1574: Choosing the ISI Filter Size for EZJIT Plus Arbitrary Data Jitter 
Analysis (at www.keysight.com, literature part number 5989-4974EN).

• ISI Fil ter Lag — When using Arbitrary mode for the Jitter Pattern Length, set the 
Lagging ISI filter coefficient. Again, to help select the correct ISI filter, see 
Application Note 1574: Choosing the ISI Filter Size for EZJIT Plus Arbitrary 
Data Jitter Analysis.

http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf


34 Keysight N8839A Hybrid Memory Cube Compliance Test Application Methods of Implementation

7 Debug Mode
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A Calibrating the Infiniium 
Oscilloscope and Probe

Oscilloscope Internal Calibration / 36
Probe Calibration / 37

This section tells where to find information on oscilloscope and probe calibration 
procedures.
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Oscilloscope Internal Calibration

For information on performing the internal diagnostic and calibration cycle for 
your Keysight Infiniium oscilloscope, refer to the "User Calibration" topic in your 
oscilloscope's online help.
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Probe Calibration

Before performing the automated tests, you should calibrate the probes. 
Calibration of the solder-in probe heads consists of a vertical calibration and a 
skew calibration. The vertical calibration should be performed before the skew 
calibration. Both calibrations should be performed for best probe measurement 
performance.

For information on performing probe vertical and skew calibration in your Keysight 
Infiniium oscilloscope, refer to the "DC Attenuation/Offset Calibration" and "Skew 
Calibration" topics in your oscilloscope's online help.

For more information on calibration/deskew procedures for your particular probe, 
refer to the probe's user's guide in the Probe Resource Center.

http://www.keysight.com/find/prc
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